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LEGAL DISCLAIMER AND CONDITION OF USE 
This document contains information for the SHOUT 3G personal satellite tracking device and 

accompanying accessories (“Product”), which is provided “as is.” Reasonable effort has been 

made to make the information in this document reliable and consistent with specifications, test 

measurements and other information. However, NAL Research Corporation and its affiliated 

companies, directors, officers, employees, agents, trustees or consultants (“NAL Research”) 

assume no responsibility for any typographical, technical, content or other inaccuracies in this 

document. NAL Research reserves the right in its sole discretion and without notice to you to 

change Product specifications and materials and/or revise this document or withdraw it at any 

time. User assumes the full risk of using the Product specifications and any other information 

provided. 

NAL Research makes no representations, guarantees, conditions or warranties, either express 

or implied, including without limitation, any implied representations, guarantees, conditions or 

warranties of merchantability and fitness for a particular purpose, non-infringement, satisfactory 

quality, non-interference, accuracy of informational content, or arising from a course of dealing, 

law, usage, or trade practice, use, or related to the performance or nonperformance of any 

products, accessories, facilities or services or information except as expressly stated in this guide 

and/or the Product and/or satellite service documentation. Any other standards of performance, 

guarantees, conditions and warranties are hereby expressly excluded and disclaimed to the 

fullest extent permitted by the law. This disclaimer and exclusion shall apply even if the express 

limited warranty contained in this guide or such documentation fails of its essential purpose. 

In no event shall NAL Research be liable, whether in contract or tort or any other legal theory, 

including without limitation strict liability, gross negligence or negligence, for any damages in 

excess of the purchase price of the Product, including any direct, indirect, incidental, special or 

consequential damages of any kind, or loss of revenue or profits, loss of business, loss of privacy, 

loss of use, loss of time or inconvenience, loss of information or data, software or applications or 

other financial loss caused by the Product (including hardware, software and/or firmware) and/or 

the Iridium satellite, or arising out of or in connection with the ability or inability to use the 

Product (including hardware, software and/or firmware) and/or the Iridium satellite to the fullest 

extent these damages may be disclaimed by law and whether advised of the possibilities of such 

damages. NAL Research is not liable for any claim made by a third party or made by you for a 

third party. 
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1 INTRODUCTION 
The SHOUT Third Generation (3G) is a handheld satellite/cellular messaging and personal 

tracking device. It is designed to operate in one of three modes; single-mode with the Iridium 

satellite network, single-mode with any cellular network including AT&T and T-Mobile, or in 

Iridium/cellular dual-mode. It can transmit location information determined by a highly 

sensitive Global Positioning System (GPS) receiver, inbound and outbound status, text 

messaging, and emergency/alert notifications. 

The SHOUT 3G significantly improves service reliability over existing tracking products by 

allowing two-way communications and confirmation of the nature of the distress to the first 

responder community. This reduces false alerts; helps identify the nature of the emergency so 

that the correct assets can be deployed, thereby reducing search and rescue costs; and 

provides communications feedback capability to the user to assist in rescue efforts. When using 

the Iridium link, the SHOUT 3G protocol is 100% backward compatible with the SHOUT, SHOUT 

nano, SHOUT ts, and SHOUT gsm. In this document, the terms SHOUT 3G and 3G are used 

interchangeably. 

The SHOUT 3G is designed with ultra-low power consumption electronics drawing less than 70 

μA during sleep. With an internal 2.15 Ah rechargeable Lithium-ion (Li-ion) battery, depending 

on the environmental conditions, it can send a position report every ten minutes for more than 

ten days (more than 1,600 reports). Read Appendix C: Power Consumption to learn about the 

impact of blocked antennas on the number of reports. The 3G is equipped with a high-

resolution color touchscreen and on-screen keyboards, allowing transmission of free-text, 

canned messages, and a combination of free-text and canned messages. The menu options are 

displayed as icons for quick access. The device can periodically wake up from sleep to send its 

position report to a network operation center. A 911 button is used for immediate 

emergency/alert notifications. Data are packaged in either standard unencrypted or 256-bit 

Advanced Encryption Standard (AES) encrypted format. 

The SHOUT 3G is capable of sending position reports and text messages in PECOS Message 

Structure (PMS). The PMS complies with the Blue Force Tracking Data Format Specification as 

defined in the document PECOS 200907-001 Version 1.7 [1]. The 3G is shipped without PMS 
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features activated and can only be enabled by NAL Research at the request of an authorized 

user. Functions related to PMS are described in Appendix A: PMS Features. 

The SHOUT 3G offers a variety of services including: 

 Normal Tracking Reports — The 3G can be programmed to automatically wake up and 

send a position report at a set interval ranging from once every minute to once every 

forty-five days (at one-minute increments). 

 Emergency Alert Reports — Pushing the Emergency 911 button immediately sends 

alert reports to a designated monitoring center(s). The home base and user can then 

communicate to define further specifics of the situation and a response to the 

emergency. 

 Free-Text Messaging — The 3G supports sending free-text messages via three different 

sets of touchscreen keyboards. 

 Canned Text Messaging — The 3G supports sending canned (pre-defined) messages 

stored in its memory. Sending canned messages saves bandwidth (effectively cost), 

because only short codes are transmitted to the server instead of the entire message 

body. 

 Waypoint Tracking — The 3G supports sending and/or saving waypoints for later 

retrieval. A waypoint is a GPS location that a user wants to identify and mark with a 

specific name tag for future reference. 

 Check-In — The 3G supports sending a quick check-in message using a single key. 

 Man Down — The 3G has an integrated motion sensor used to activate alerts in a man-

down situation. 

 Geofencing — The 3G accepts multiple fences defined as polygons (50 fences with up 

to 50 points each fence). The 3G can be activated based on conditions set by these 

fences. 

 Data Logger — The 3G has a circular buffer and can be programmed to store up to 

4,000 positions for later retrieval. 

Important: NAL Research can enable the SHOUT 3G for use on the Department of Defense 

(DoD) Enhanced Mobile Satellite Services (EMSS) Iridium Gateway (only for the Iridium network 
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and not cellular networks). However, accessing the EMSS Iridium Gateway is not authorized 

until the SHOUT 3G is provisioned (signed up for airtime). Unauthorized attempts to access the 

EMSS Gateway will result in immediate disabling of the offending device, which must then be 

returned to NAL Research for repair. See https://emss.pac.disa.mil/home.shtml for more 

information regarding DoD EMSS service provisioning. 

Important: Do not disassemble the 3G for repairs or service. The warranty is voided if the 3G is 

disassembled. Return it to NAL Research for services by calling 703-392-1136 x203 or emailing 

contact@nalresearch.com. 

https://emss.pac.disa.mil/home.shtml
mailto:contact@nalresearch.com


  SHOUT 3G User Guide Version B 

Document Number: 451-93218-002B 15 of 69 

2 USING THE SHOUT 3G 

2.1 DEVICE DESCRIPTION 

The SHOUT 3G comprises a touchscreen, a Power/Back button, a status LED, a guarded 

Emergency 911 button, and a USB Micro-B port.  

 The touchscreen provides easy access to the device features. 

 The Power/Back button turns on the device and can also be used as a back key.  

 The Light-Emitting Diode (LED) displays device status during emergency and tracking. 

 The guarded Emergency 911 button activates a dedicated emergency message 

sequence until cancelled by the user. 

 The Universal Serial Bus (USB) Micro-B port is for charging, firmware updates, and 

setting parameters using the NAL Research SatTerm application.  

Important: Unlike the cellular link that can be used indoors, the SHOUT 3G must have full view 

of the sky when the Iridium link is used. 
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Figure 1: SHOUT 3G Exterior Components 

2.2 ACCESSORIES 

The SHOUT 3G includes the following accessories. 

  

AC Wall Adapter USB-A to USB Micro-B Cable 

Figure 2: SHOUT 3G Accessories 

Power/Back Button 

Iridium Antenna 

Touchscreen 

USB Micro-B Interface 

LED Status Display 

GPS Antenna 

Embedded Cellular Antenna 

Cellular micro-SIM Holder 

Guard 

Pull USB/SIM cover off. Load  
any cellular micro-SIM card, 
including AT&T and T-Mobile. 

Push micro-SIM to eject 

Emergency 911 Button 
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2.3 CHARGING THE BATTERY 

The SHOUT 3G is shipped with its internal Li-ion battery partially charged. Fully charge the 3G 

before use. There are two ways to charge the 3G: 

 Use the supplied AC wall adapter.  

o The charging time is approximately five hours. 

 Connect to a standard USB device.  

o The charging time depends on the type of USB port.  

 USB 1.0 should be able to charge the 3G in about a day, assuming the port is 

capable of producing an output current of 100 mA.  

 USB 2.0 can charge in about 8 hours, assuming the current output of 0.5 A. 

A common 2 amp USB wall adapter can fully charge the device in under 3 hours. NAL Research 

offers 12 VDC and 28 VDC chargers sold as separate items. 

 

The 3G has a battery status symbol    at the top-right corner of its touchscreen indicating 

the battery is being charged. A message appears when charging is complete. The device can be 

safely operated and does not need to be turned off while charging. The charging cycle 

completes quicker when the device is turned off. While using the 3G, the battery symbol turns 

red when the remaining power is less than 20%. A warning message appears when the 

remaining power is less than 10%. 

WARNING! 

All batteries can cause property damage, injury, or burns if a 
conductive material, such as jewelry or keys, touches exposed 
terminals. The material may complete an electrical circuit and become 
extremely hot. To protect against such unwanted current drain, 
exercise care in handling any charged battery, particularly when 
placing it inside your pocket, purse, or other container with metal 
objects. 

Do not disassemble the SHOUT 3G for battery replacement. Return it 
to NAL Research for services. Risk of explosion if battery is replaced 
with an incorrect type. Dispose of the batteries (3G) according to local, 
state, and federal regulations or laws. 
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2.4 CELLULAR SIM CARD 

The SHOUT 3G has a cellular micro- Subscriber Identification Module (SIM) card slot on the side 

of the chassis next to the USB Micro-B port. For cellular services, the SHOUT 3G accepts any 

cellular micro-SIM with services on a network that supports 2G Global System for Mobile 

Communications (GSM)/GPRS and 3G Universal Mobile Telecommunications System (UMTS)/ 

High-Speed Downlink Packet Access (HSPA) services. A 4G LTE-only network will not support the 

SHOUT 3G. NAL has validated SHOUT 3G operation on both AT&T and T-Mobile networks. Due 

to network device requirements, the Verizon network is not supported. Request an account 

that supports SMS service, packet switch data service, or both. 

2.5 TOUCHSCREEN 

The SHOUT 3G has a resistive touchscreen. Use either a finger or a stylus to select options 

displayed on the screen. Resistive touchscreens offer consistent and durable performance in 

harsh environments. However, as with any touchscreen device, be careful not to damage it with 

a sharp object. A plastic stylus with a rounded tip is recommended. Unlike a capacitive 

touchscreen found on most cellular phones where a slight tap of the finger is required, a 

resistive touchscreen requires more moderate finger pressure. Resistive touchscreens drift 

slowly over time and need to be recalibrated periodically. To do this, open the Setting > 

Calibrate menu. 
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Figure 3: Resistive Touchscreen 

2.6 BASIC NAVIGATION 

 Turn on the SHOUT 3G by holding down the Power/Back   button for 

approximately two seconds.  

Note: A delay in displaying time and date is normal because the unit must first check its 

internal clock against the GPS receiver.  

 Once the device is on, touch any icon to access device features.  

Note: Remember to apply moderate pressure with a fingertip. Resistive screens require 

more pressure than a slight touch.  

 Press the Power/Back button at any time to return to the previous screen.  

 Frequently used icons can be configured to appear at the bottom of the Home menu in 

the Favorites bar using Settings > Favorites.  

 Turn off the 3G (completely off with no tracking or text messaging) at any time by 

holding down the Power/Back button for approximately two seconds. The device 

automatically “goes to sleep” after 90 seconds of inactivity. 

Either a stylus or gloved finger 
can be used to access features on 
the resistive touchscreen 

http://www.google.com/imgres?q=gloves&hl=en&safe=off&biw=1205&bih=647&gbv=2&tbm=isch&tbnid=h3dLUjg3VlqjSM:&imgrefurl=http://www.bigleaguestore.com/akadema-baseball-batting-gloves-c-68_32.html?sort%3D2d%26page%3D1&docid=8XIsvk4AYZzzUM&imgurl=http://www.bigleaguestore.com/images/batting-gloves-grey-red.jpg&w=400&h=400&ei=ef6XT9GgAsTV0QHUwOG7Bg&zoom=1&iact=hc&vpx=477&vpy=2&dur=135&hovh=225&hovw=225&tx=122&ty=83&sig=106668968113636696585&page=4&tbnh=146&tbnw=146&start=69&ndsp=24&ved=1t:429,r:20,s:69,i:334
http://www.google.com/imgres?q=gloves&hl=en&safe=off&biw=1205&bih=647&gbv=2&tbm=isch&tbnid=h3dLUjg3VlqjSM:&imgrefurl=http://www.bigleaguestore.com/akadema-baseball-batting-gloves-c-68_32.html?sort%3D2d%26page%3D1&docid=8XIsvk4AYZzzUM&imgurl=http://www.bigleaguestore.com/images/batting-gloves-grey-red.jpg&w=400&h=400&ei=ef6XT9GgAsTV0QHUwOG7Bg&zoom=1&iact=hc&vpx=477&vpy=2&dur=135&hovh=225&hovw=225&tx=122&ty=83&sig=106668968113636696585&page=4&tbnh=146&tbnw=146&start=69&ndsp=24&ved=1t:429,r:20,s:69,i:334
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2.7 USING THE KEYBOARDS 

Some menu options require the use of on-screen keyboards to enter information. Three 

different keyboards are available in landscape orientation—lower case, upper case, and 

number/special characters. Switch between keyboards with special designated keys next to the 

Done key. The keyboard screen is divided into three sections as shown in Figure 4 below: (1) 

header bar, (2) text box, and (3) keyboard. 

The number displayed on the far right-hand side of the header bar indicates the remaining 

allowable number of characters that can be entered into the text box. 

 

Figure 4: Keyboard Screen 

Use the keyboards to enter text inside the text box. The recommended hand-position is shown 

in Figure 5 below utilizing two thumbs to tap the keyboard. While entering text, the position of 

the cursor in the text box is shown as a flashing white block. The block turns red when the 

maximum limit is reached (Remaining: 0). An alert sounds when the maximum number of 

characters is exceeded and additional text is entered. 

You can hold down any key while sliding around the keyboard. The key is not entered until the 

finger is lifted. Moving the finger away to the top or bottom of the screen cancels this option. 

The entire text box can be erased with the Clear button. Unclear reverses the process. Tap Done 

to accept entered text and return to the previous screen. Press the Power/Back key   to 

return to the previous screen without saving any changes—all the changes will be lost. 

 

 

 

 

 
 

Keyboard 

Text Box 

Header bar 

 Cursor (flashing) 
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Figure 5: Keyboard Hand-position 

Edit entered text by tapping anywhere inside the text box. It is much easier to use a fingernail 

or a stylus to accurately position the cursor over the character to be edited. Holding and sliding 

a finger inside the text box prompts the device to display a segment of the text in the header 

bar as shown in Figure 6 below. The position of the cursor is displayed in red character. A space 

and enter key will appear as  and , respectively. 

 

Figure 6: Hold and Slide on Keyboard 

q     w    e      r     t     y     u      i     o     p 

a     s     d     f      g    h      j     k     l     

ABC   z     x     c      v    b     n    m   @  
Done      123   -             .    ,    Clear  

                                 Enter Text          Remaining:309 

Meet me at the next stop. 

 

 

 

 

 
 

 

Finger position 
highlighted in 
red character 
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2.8 USING THE SEARCH BOX 

Some menu options have a Search box to search for specific keywords or phrases. The search 

parameters are defined using Settings > Search menu. Touching the Search box opens a 

keyboard to enter the search item. 

 

Figure 7: Search Box 

2.9 USING THE SLIDER BAR 

For menus with options longer than the screen can display, a slider bar appears on the right 

side of the screen. Hold and drag the slider with a fingertip to quickly scroll the list. A slight 

finger movement either up or down makes the 3G scroll one line at a time. 

Search Box 
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Figure 8: Slider Bar 

Tapping above the slider prompts the screen to page up and tapping below the slider prompts 

the screen to page down. The active area or detection region of the slider bar is wider than the 

slider bar itself. Thus, it is possible to place a finger slightly away from the right edge of the 

screen to give a more comfortable feel. 

2.10 NETWORK OPERATION CENTER (NOC) 

The SHOUT 3G comprises a 9603 module capable of Short-Burst Data (SBD) connectivity to the 

Iridium satellite network and a 2G/3G cellular module capable of Short Message Service (SMS) 

and Internet Protocol (IP) connections. As a messaging and tracking device, its function is to 

send GPS reports and text messages to a Network Operation Center (NOC). While deployed in 

the field, the 3G can also accept real-time text messages and commands from a NOC. For 

Iridium services, the SHOUT 3G can be provisioned by NAL Research or any certified Iridium 

airtime service provider including, DoD Defense Information Systems Agency (DISA) EMSS 

office. For cellular services, the SHOUT 3G accepts any cellular micro-SIM, including AT&T and 

T-Mobile. 

A NOC can be a sophisticated central monitoring center equipped with servers connected to 

high-speed networks. A NOC can also be as simple as a handheld mobile device, a laptop, or a 

 Either slide to quickly scroll up and down 
 or tap to page up and down 
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desktop attached to the internet, to an Iridium transceiver, or to any wireless network. A NOC is 

required to implement the logic necessary to receive and analyze messages from the SHOUT 3G 

and determine the appropriate response, as well as to formulate and transmit messages to the 

SHOUT 3G. 

2.11 SERVER FOR TRACKERS SOFTWARE 

Upon request, NAL Research provides Server for Trackers software, which you can install on 

your NOC to retrieve NAL Research’s formatted GPS reports from the remote SHOUT 3G. In 

addition, the program lets a NOC communicate with modems attached to its serial ports, 

communicate with Post Office Protocol 3 (POP3)/ Simple Mail Transfer Protocol (SMTP) servers, 

communicate with Iridium SBD DirectIP servers, and/or act as a Router-Based Unrestricted 

Digital Internetworking Connectivity Solution (RUDICS) server/client to support incoming and 

outgoing communications with the 3G. Under special cases and with a signed Non-Disclosure 

Agreement (NDA), NAL Research will release our proprietary GPS report formats for developers 

to implement into their own tracking software. 

2.12 SATTERM APPLICATION 

Use the included SatTerm application to set up the SHOUT 3G operating parameters, 

geofences, contacts, and canned messages. Most of the operating parameters can be set using 

the 3G on-screen menus. However, if multiple changes must be made, SatTerm is a more 

efficient means to achieve this. SatTerm configuration files can be saved for loading into 

multiple devices. Also, more sophisticated features such as encryption and geofence must be 

carried out via SatTerm and a computer connected to the 3G. For contacts and canned 

messages, the 3G sends only short codes instead of the message body to a NOC server. Short 

codes are then mapped to the real addresses and/or canned messages with a lookup table 

saved on the NOC server during setup. Therefore, when SatTerm is used to enter contacts and 

canned messages, SatTerm synchronizes short codes between the 3G and the NOC server. 

Email addresses, on the other hand, can be entered on the fly. 
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2.13 NAL VUE MANAGEMENT TOOL 

NAL Vue is a web-based locating, tracking, and communication management system that 

provides your team with situational awareness and control to make timely and effective 

mission decisions. NAL Vue is an integrated system bringing satellite, cellular, and other data 

together into a single and simple-to-manage display and control platform. NAL Vue tracks your 

assets by location and movement (position, speed, altitude, and heading) in real-time via GPS 

updates from your NAL Research devices and other compatible tracking devices. 

The flexibility of the NAL Vue Asset Management System offers awareness of position over your 

global inventory of trackable assets such as the SHOUT ns. Whether you are tracking personnel, 

vehicles, shipping containers, etc., your designated system administrator maintains control and 

has the ability to communicate with any number of assets simultaneously. Conversely, NAL Vue 

does not allow others to see the location or movement of your assets unless you authorize it. 
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3 HOME SCREEN 
1. Immediately after turning on the device, select the Press To Unlock bar located at the 

bottom of the screen.  

Note: A delay in displaying time and date is normal because the unit has to check its 

internal clock against the GPS receiver.  

2. Enter a Personal Identification Number (PIN), if the device is set up with password 

protection.  

Note: NAL Research ships the 3G without password protection. However, if a PIN is 

factory-set, it should be 1111. 

The Home screen appears. Device status symbols are displayed along the top three 

lines of the home screen. Some symbols will not appear until an event is initiated, such 

as sending or receiving a message. 

 

Figure 9: Open Home Screen 

Splash Screen with Press To 
Unlock Button 

Home Screen 
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3.1 STATUS SYMBOLS 

Table 1: Status Symbols 

 

Denotes the primary network used to transmit reports/messages. Either Iridium 
or GSM label appears. To preserve battery life the Iridium transceiver and cellular 
module are only turned on when transmitting a message or position report; thus, 
a diagonal line is drawn over the symbol when off. 

 

Denotes either: (1) the Iridium transceiver or cellular module is on with real-time 
signal strength represented by the number of vertical bars or (2) SBD/SMS/IP 
message transmission is in progress. The signal strength can range from the 
lowest of zero to the highest of five bars. During transmission and with the Iridium 
link, the antenna must have a clear view of the sky. The SHOUT 3G cannot send 
messages or reports via the Iridium network from inside a building. 

 
Denotes the GPS receiver is off. The GPS receiver is always kept off to preserve 
battery life until time, date, or position information is needed. 

 

Denotes the GPS receiver is on with real-time satellite acquisition status 
represented by the number of vertical bars.  

 One bar represents valid time and date fix.  

 Two bars represent 2D fix or dead reckoning. 

 Three bars represent 3D fix with HDOP higher than 2.0.  

 Four bars represent 3D fix with HDOP less than 2.0.  

Although the SHOUT 3G’s GPS receiver can often obtain a location fix when the 
antenna is partially blocked (near buildings, in a room next to a window, etc.), the 
antenna must have a clear view of the sky to minimize acquisition time, provide 
better position accuracy, and reduce power consumption. 

 Battery charge indicator. 

 Denotes the battery is being charged by an external power source. 

 Denotes all audio alerts are off. 

 Denotes audio alert is on. 

 Denotes an unread message(s) is in the Inbox. 

 
Denotes a message(s) is in the Outbox ready to be sent or a message(s) in queue 
failed to send. 
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Table 1: Status Symbols 

 
Denotes Mailbox Check has been enabled when the symbol is bright white. The 
symbol turns dimmed gray when Mbox Check is off. 

 

Denotes Geofences has been enabled when the symbol is bright white. The 
symbol turns dimmed gray when geofence tracking is off. The geofence symbol 
does not appear when there are no fences saved into the device. 

 

Denotes Call Out has been enabled when the symbol is bright white. The symbol 
turns dimmed gray when Call Out is off. The Call Out symbol does not appear 
when there are no Call Out times saved into the device. 

 

Denotes tracking (standard tracking, geofence tracking, etc.) has been enabled 
when the symbol is bright white. When standard tracking is on, a countdown 
timer to initiation of the next report appears beside the tracking symbol. The 
symbol turns dimmed gray when tracking is off. 

 
Denotes Man Down has been enabled. 

 

3.2 DATE/TIME 

The current date and time are displayed in formats set by the Settings > Time > Date option. 

The GPS receiver has an internal clock; as long as the battery is not depleted and a valid 

position fix was previously acquired, the SHOUT 3G can recall the correct date and time. The 

message “Date/Time unavailable” is displayed when the 3G is unable to restore information 

from the GPS receiver. 

3.3 HOME ICONS 

The SHOUT 3G displays four main icons on its home screen (as shown in Figure 10 below), each 

representing a menu option—Texting, Tracking, Utilities, and Settings. Detailed descriptions of 

each of these menu options and their submenus are included in the next section. 
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3.4 FAVORITE ICONS 

The bottom of home screen has a favorites bar to provide quick and easy access to the most 

frequently used options. You can configure any of the menu icons to appear on the favorites 

bar using Settings > Favorites. A maximum of four favorite icons is allowed. The icons appear in 

the order of selection from left to right, as shown in Figure 10 below. 

 

Figure 10: Home Screen with Four Favorites Bar Icons 
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4 QUICK START 
Airtime services must first be purchased for Iridium, cellular, or both before use. Purchase 

Iridium airtime directly from NAL Research or from any of Iridium certified airtime resellers. A 

cellular micro SIM card, including prepaid SIM cards, on a network that supports 2G GSM/GPRS 

and 3G UMTS/HSPA services is required for the SHOUT 3G. A 4G LTE-only network will not 

support the SHOUT 3G. NAL has validated SHOUT 3G operation on both AT&T and T-Mobile 

networks. Due to network device requirements, the Verizon network is not supported. Request 

an account that supports SMS service, packet switch data service, or both. 

Reading the entire manual is helpful to learn how to operate the 3G as a messaging device. As a 

tracking device, you can quickly set up the 3G with just a few simple steps shown below. 

However, a server is required to receive tracking reports. 

1. Turn the 3G on by holding down the Power/Back button   for about two seconds. 

2. Go to the Tracking > Format menu  to set the report format. 

3. Go to the Tracking > Links menu  to select a network(s). 

4. Go to the Tracking > Rpt Rate menu  to set the reporting rate and turn tracking on. 

The 3G is now in tracking mode and ready to send position reports. No further action is 

required. The unit automatically goes to “sleep” in between reports. 

Important: NAL Research can enable the SHOUT 3G for use on the DoD EMSS Iridium Gateway 

(only for the Iridium network, not the cellular network). However, accessing the EMSS Iridium 

Gateway is not authorized until the SHOUT 3G is provisioned (signed up for airtime). 

Unauthorized attempts to access the EMSS Gateway will result in immediate disabling of the 

offending device, which must then be returned to NAL Research for repair. See webpage 

https://sbd.pac.disa.mil for more information regarding DoD EMSS service provisioning. 

https://sbd.pac.disa.mil/
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5 TEXTING MENU 
Use the Texting menu to compose, save, view, and send canned or free-text messages, 

check the mailbox for incoming messages, and set up an automatic mailbox check 

frequency. 

 

Figure 11: Texting Menu 

5.1 INBOX 

The Inbox folder contains all incoming read and unread messages with the newest at the 

top of the list. Read messages have a white opened envelope symbol  next to them. 

Unread messages have a green closed envelope symbol  next to them. A closed envelope 

symbol  appears at the top of the screen when one or more unread messages are in the 

Inbox. Go to the Settings > Audio menu to enable the speaker, which provides an audible alert 

for all new incoming messages. 

5.2 DRAFTS 

The Drafts folder contains draft messages saved under the Compose menu. The 3G 

stores the newest message at the top and the oldest message at the bottom of the list.  

1. Select a draft message to open the Compose screen.  

2. Select Send. A Confirm and then a Success box appear to indicate that the message has 

been added to the Outbox.  
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Note: If the Inc GPS option is enabled, then GPS location will be attached to a message. 

Messages with GPS location attached can take longer to send because the 3G has to 

acquire a GPS position. 

5.3 OUTBOX 

The Outbox folder contains either messages waiting to be sent or messages that failed to 

send. A message in the process of being sent has a << symbol next to it. A message that 

failed to send has a red X symbol. A message in queue waiting to be sent has no symbol. For 

each message queued in the Outbox waiting to be sent, the 3G has a two-minute window to 

transmit. Then the message will be dequeued to avoid draining the battery.  

Messages that failed to send remain in the Outbox sorted in the order of priority and then by 

the oldest to the newest messages. The symbol  appears at the top of the screen when there 

is a queued or dequeued message(s) in the Outbox. 

Failed messages can be deleted or resent (enqueue). However, if you resend a failed message 

and if the failed message is successfully retransmitted, the SHOUT 3G automatically attempts to 

resend as many remaining failed messages in the Outbox as possible in the following order of 

priority. 

Category 1 (highest priority): 

Callout 

Cancel Emergency 

Geofence Arrive/Depart 

Man Down 

Category 2: 

Check-In 

Queued Tracking Report 

Category 3: 

Motion Start/End Report 

Statistics Report 

Test Report 

Category 4 (lowest priority): 

Remote Update Response 

Poll Report 

Text Message  

Waypoint 
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If there are multiple items in the same category, the oldest will be sent first. The SHOUT 3G 

automatically resends failed messages in the order stated above after a successful transmission 

(by accessing the network through methods such as Tracking, Test Report, Waypoint, etc.). To 

avoid draining the battery, maintain the Outbox frequently and delete unwanted failed reports. 

5.4 SENT 

The Sent folder contains messages successfully sent to a NOC server. A message can be 

resent, forwarded, or deleted.  

 Resend moves a message to the bottom of the Outbox folder’s sending queue.  

 Forward opens the Compose menu to enter additional information. You can then 

resend the message after modifying it or cancel the process.  

 Delete permanently removes the message from the Sent folder.  

The 3G stores messages in the Sent folder with the newest message displayed at the top of the 

list. 

5.5 COMPOSE 

The Compose menu provides options to enter, edit, and send canned messages, free-text 

messages, or a combination of canned and free-text messages to: (1) a NOC server, (2) a 

predefined list of email addresses, and/or (3) any email addresses entered via the keyboards. 

SatTerm software creates and saves predefined email addresses onto the SHOUT 3G’s contact 

list. During setup SatTerm requires connectivity between the 3G and a NOC server to 

synchronize the lookup table of short codes. As with canned messages, short codes map the 

actual email addresses to a lookup table located at a NOC. 

To compose a message: 

1. Select the Compose menu. A screen appears with two distinct regions: “To: Server” and 

“Canned Message.” 

2. Hold a finger inside the To: Server region. The SHOUT 3G displays two options, Choose 

Contacts and Enter Emails, as shown in Figure 12 below.  
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Figure 12: Choose Contacts or Enter Emails 

o You can slide a finger back and forth between these two options. 

o Remember to apply moderate pressure on the touchscreen while sliding the finger. 

DO NOT lift the finger until the right choice is selected.  

o Sliding the finger away to the top of the screen or bottom of the screen cancels this 

option. 

3. Choose Contacts 

a. If Choose Contacts is selected and if contacts were entered with SatTerm, a list of 

contacts appears in alphabetical order.  

b. Select a single contact or multiple contacts on the list and tap Add to accept.  

c. Remove a contact by going back to Choose Contact, unselecting the contact, and 

tapping Add.  

Note: Pressing the back key instead of Add after selecting or unselecting a contact 

cancels the choice(s). 
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Figure 13: Choose Contacts 

4. Enter Emails 

a. If Enter Emails is selected, a keyboard appears.  

b. Multiple email addresses can be entered separated by a comma.  

Note: All email addresses, including the commas, must be a total of 255 characters 

or less. The SHOUT 3G keeps track of the limit and prevents entering email 

addresses longer than allowed. Email addresses and free-text messages share the 

same memory space with a maximum allowable length of 309 characters. Long 

email addresses or multiple email addresses reduce the number of characters 

available for a free-text message.  

Note: The 3G sends short codes representing the contacts listed under To; 

however, the 3G sends the actual email addresses listed under Emails. Any email 

addresses entered under Enter Emails can be removed by going back to the 

keyboard under the Enter Emails pop-up menu. 

5. Hold a finger inside the Canned Message region to view two options—Choose Can’d 

Msg and Enter Text.  
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Figure 14: Choose Can'd Msg and Enter Text Options 

6. If Choose Can’d Msg is selected and if canned messages were entered with SatTerm, a 

list of canned messages appears in the order they were entered with SatTerm.  

 

Figure 15: Select a Canned Message 

a. Tap a canned message to view the complete canned message. 
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b. Tap Select to choose the message.  

c. Hold a finger inside the Canned Message region to view the Remove Can’d Msg 

option. Select Remove Can’d Msg to remove the selected canned message at any 

time, even after free-text has been entered. 

Note: As with the contact list, SatTerm is used to create and save canned messages 

into the SHOUT 3G’s memory. During setup, SatTerm requires connectivity between 

the 3G and a NOC server to synchronize the lookup table of short codes. Sending 

canned messages saves bandwidth and airtime cost because only short codes are 

being transmitted instead of the entire message body. The short codes are defined 

by application developers and not by the 3G. 

7. Enter Text 

a. Use the Enter Text option to create free-text messages with three on-screen 

keyboards (see the Using the Keyboards section). If a canned message is previously 

selected, then the entered free-text will be appended to the canned message. 

8. Send the message or save as a draft.  

a. If Send is selected, a Success screen appears to indicate that the message has been 

added to the Outbox. Hold the 3G with the antennas having an unobstructed view 

of the sky if using the Iridium link.  

i. If Inc GPS option is turned on, then GPS location will be added to the message. 

Messages with GPS location take longer to send because the 3G has to acquire a 

GPS fix. 

5.6 CONTACTS 

The Contacts option is an address book with a list of contacts created and saved into the 

SHOUT 3G’s memory using NAL Research’s SatTerm software. During setup, SatTerm 

requires connectivity between the 3G and a NOC server to synchronize the lookup table of 

short codes. As with canned messages, short codes are used to map real addresses to a lookup 

table located at a NOC. 
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Figure 16 below displays an example of the formatted contact defined by the NAL Research’s 

NOC server. The first line has the contact name, the second line has the email address, the third 

line has the phone number, and the fourth line has the home address.  

Each contact is stored in a four-line format. The first line can have up to 30 characters, the 

second can have 50 characters, the third can have 30 characters, and the fourth can have 30 

characters. The information contained in each line is defined by developers and not by the 3G. 

Upon receiving a free-text or canned message from the 3G that is referenced to a specific 

contact, the NAL Research’s NOC server forwards the message to the email address listed on 

the second line of the contact. Application developers can define their own set of rules with 

information contained in the contact so that their NOC servers can use them to determine the 

appropriate response. 

 

Figure 16: Formatted Contact 

5.7 CHK MBOX 

The Check Mailbox [Chk Mbox] option is available ONLY when the Iridium link is enabled. 

There are three ways the SHOUT 3G can initiate a mailbox check for any pending messages at 

the Iridium gateway: 

 Manually force the 3G to check the mailbox at any time using Chk Mbox menu. 
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 When tracking mode is enabled, the 3G automatically checks the mailbox each time it 

wakes up and successfully sends a position report. 

 Using the Mbox Rate menu (see below for detailed description), the 3G can be set to 

automatically wake up and check the mailbox at a preset frequency. A position report 

will not be sent when the 3G wakes up to check the mailbox unless the mailbox check 

rate coincides with the tracking report rate. 

The Check Mailbox menu can either be Idle or Checking the Iridium gateway for any pending 

messages to be downloaded. As the messages are being downloaded, the 3G shows the 

number of unread messages in the Inbox and the number of messages still queued at the 

Iridium gateway to be downloaded, as shown in the figure below. 

 

Figure 17: Check Mailbox Menu 

5.8 MBOX RATE 

The Mailbox Check Rate [Mbox Rate] option is available ONLY when the Iridium link is 

enabled.  

The Mbox Rate is used to set mailbox check rate (time between mailbox checks) and to enable 

mailbox checks automatically. Select either a predefined rate or a user-defined rate with an on-

screen keypad. The Mailbox Check Rate menu is dimmed when mailbox check is disabled. 

However, even when mailbox check is disabled and the labels are dimmed, you can still enter 

the rate. 
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Figure 18: Mailbox Check Rate 

When mailbox check is enabled, the symbol  lights up from dimmed gray to bright white at 

the top of the screen. The 3G checks the Iridium gateway automatically for any pending 

messages at the next scheduled time. When mailbox check is enabled and the 3G sleeps in 

between checks, the status LED flashes once every five seconds. The status LED can be turned 

off during sleep to reduce power consumption by using the Settings > LED menu. 

5.9 INC GPS 

The Include GPS [Inc GPS] option forces the SHOUT 3G to attach GPS location to Check-In 

and canned and free-text messages. Under the default setting, these messages do not 

have GPS information included. Messages with GPS location attached can take longer to 

complete because the 3G has to acquire a GPS fix first. Depending on the validity of the stored 

satellite ephemeris data, it could take up to an additional 29 seconds. 

5.10 MEMORY 

Memory is used to clear messages in all mailboxes or clear messages in each individual 

box—Drafts, Inbox, Outbox, and Sent. 

Labels are 
dimmed when 
mailbox check 
is disabled 

Enable/Disable 
mailbox check 

Mailbox check 
is enabled 
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6 TRACKING MENU 

6.1 TRACKING 

The Tracking menu for the SHOUT 3G is shown in Figure 19 below. Some options are 

very complex and require SatTerm to set up, including Geofences, cellular IP routing, and 

Call Out. For these options, refer to the “SatTerm for SHOUT 3G” manual [2]. 

 

Figure 19: Tracking Menu 

6.2 RPT RATE 

The Report Rate [Rpt Rate] is used to enable tracking and to set the tracking report rate 

(time between tracking reports). You can select either a predefined rate or a user-

defined rate with an on-screen keypad. The Reporting Rate menu is dimmed when tracking is 

disabled. However, even when tracking is disabled and the labels are dimmed, you can still 

enter the report rate. 

The On/Off buttons enable/disable the SHOUT 3G tracking mode. When tracking is on, the 

tracking symbol  at the top of the screen changes from dimmed gray to bright white. The 3G 

immediately turns the GPS receiver on to acquire a GPS fix and then attempts to transmit a 

position report. The next position report is sent automatically based on the reporting rate. The 

countdown timer to the next report is displayed inside the parentheses next to the tracking 

symbol. When tracking is enabled and the 3G sleeps in between position reports, the status LED 
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 flashes once every five seconds. It can be turned off during sleep to reduce power 

consumption by using the Settings > LED menu. Activate the Emergency 911 button at any time 

during tracking mode or non-tracking mode. The 3G can also be turned on at any time and used 

as a texting device. 

When waking up to transmit a location report and the Iridium link is used, the 3G antennas 

must have an unobstructed view of the sky; otherwise, it may fail to send. By default, a failed 

report will not be resent. Using the Q Rpt menu, failed reports can be forced to stay in the 

Outbox awaiting to be resent (see the Outbox description). 

The entire reporting duration can take up to two minutes depending on the Iridium satellite 

visibility and the validity of the GPS ephemeris data. Ephemeris data saved on the GPS receiver 

is valid for approximately two hours, allowing the receiver to obtain a hot-start fix with a less 

than 1 second hot start delay. Report rate (time between reports) set to more than two hours 

forces the GPS receiver into a cold-start fix (~29 seconds). As a result, the 3G consumes more 

battery power and the total number of reports is reduced. For more information, see Appendix 

C: Power Consumption. 

Important: The SHOUT 3G automatically resends all failed messages in the Outbox after a 

successful position report transmission. To avoid draining the battery unnecessarily, carry out 

frequent maintenance on the Outbox and delete unwanted failed messages. 

The 3G logs and saves all position reports in its circular memory. When its memory is full, the 

oldest report is overwritten. SatTerm can be used to retrieve all position reports saved on the 

3G. 

6.3 FORMAT 

The SHOUT 3G can transmit position reports in either 30-byte format or 10-byte format. 

Both of these formats are backward compatible with the SHOUT nano and SHOUT ts.  

The 30-byte format includes UTC date, UTC time, latitude, longitude, altitude, speed, course, 

vertical velocity, number of satellites used to obtain 3D fix, Horizontal Dilution of Precision 

(HDOP), and Vertical Dilution of Precision (VDOP). Latitude and longitude are recorded with 

about 0.18 meters in resolution. 
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The 10-byte format includes Coordinated Universal Time (UTC) time, latitude, longitude, and 

Position (3D) Dilution of Precision (PDOP). With UTC date omitted, the 3G relies on the NOC 

server to stamp the date as the report arrives. Encryption is not available with the 10-byte 

format. Latitude and longitude are recorded with about 1.1 meters in resolution. The 10-byte 

format is selected solely for the purpose of Iridium airtime cost-saving. 

The 3G can also send position reports in PECOS Message Structure (PMS). The PMS complies 

with the Blue Force Tracking Data Format Specification. The 3G is shipped without PMS features 

activated and can only be enabled by NAL Research at the request of an authorized user. For 

Functions related to PMS, see Appendix A: PMS Features. 

6.4 LINK 

The Link option assigns the network(s) used to transmit reports and messages. Three 

options are available—Iridium network only, cellular network only, or both. If both 

networks are allowed, another menu appears requiring you to select a primary network. The 

SHOUT 3G always uses the primary network to transmit reports and messages. The secondary 

network is only used if the primary network is not available. Switching between primary and 

secondary networks is managed by the SHOUT 3G automatically. The SHOUT 3G’s default link 

setting is both, with the Iridium network as the primary link. Some options are available only on 

one network but not the other. 

 

Figure 20: Configure Links 

A primary link 
must be 
selected when 
both Iridium 
and cellular are 
allowed. 
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6.5 SMS RT 

The SMS Routing [SMS Rt] option is ONLY applicable to the cellular network. Two options 

are available in routing reports/messages to an end destination (or a NOC server) when 

using the cellular network—SMS and IP. When configured for SMS, the SMS Rt menu provides 

options for routing to either an SMS phone number or an email address. The phone number 

should be the number for a phone or a device (specific to the cellular carrier) capable of 

receiving SMS messages. When selecting a phone number, select national or international to 

specify the format of the phone number. If the format is unknown, choose national. If email 

address routing is desired, provide a routing phone number (e.g., T-Mobile routes SMS emails 

with phone number 500 and AT&T routes SMS emails with phone number 121) along with the 

email address. Messages and reports can also be routed to an IP address. The IP option is only 

configurable through SatTerm. Refer to the “SatTerm for SHOUT 3G” manual [2]. 

6.6 GEOFENCES 

In addition to “standard” tracking enabled through the Rpt Rate menu (refer to section 

6.2), Geofences is another tracking option tailored for specific applications. Geofence 

tracking works independently as a separate tracking mode or can be implemented along with 

standard tracking. Setting geofence parameters is complex. NAL Research recommends the use 

of both SatTerm and Google Maps®. However, you can also enter a sequence of latitude and 

longitude pairs to define a fence. Refer to the “SatTerm for SHOUT 3G” manual [2]. 

A geofence is a polygon defined by a set of connected latitude and longitude coordinates that 

defines a region or zone of interest. A geofence must be bounded by a minimum of 3 

coordinates and a maximum of 50. Each fence has a unique tracking profile that triggers the 

SHOUT 3G to change its tracking behavior while inside a specific fence; e.g., it allows the SHOUT 

3G to use Iridium, cellular, both Iridium and cellular, or to turn off all transmitting radio links 

(Iridium and cellular) for regions that require radio silence. A geofence can be configured to 

send special arrival/departure reports upon entering and/or exiting the fence. 
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Figure 21: Geofences Enabled/Disabled 

The Geofences menu provides a few options including: (1) browsing a list of fences loaded into 

the device through SatTerm, (2) viewing the map of each fence and its type of notification 

(arrival or departure), and (3) enabling/disabling a fence. Enter other geofence features 

through SatTerm. 

 

When a fence or fences are enabled, the Geofences symbol  at the top of the screen 

changes from dimmed gray to bright white. The 3G immediately checks the GPS receiver to 

determine whether the device is inside an enabled fence. If the 3G is inside an enabled fence, 

the Geofences symbol turns green and the fence label also turns green with the word Active 

attached to it. When a fence(s) is enabled and the 3G sleeps, the status LED  flashes once 

every five seconds. You can turn it off during sleep to reduce power consumption by using the 

Settings > LED menu. 

Enable/Disable a 
fence Enabled fences 

Labels are 
dimmed on 
fences that are 
disabled 
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Figure 22: Geofences Green When Active 

6.7 BREVITY 

The Brevity code is part of the PMS format. The 3G ignores the Brevity code settings, if 

the PMS/PECOS format is not activated and not selected. View functions related to 

Brevity code in Appendix A: PMS Features. 

6.8 MAN DOWN 

The Man Down option allows you to set the options used by the Man Down Alert 

feature. The Man Down Alert detects when the SHOUT 3G is motionless for a 

configurable amount of time and triggers up to 3 different alerts if you do not respond 

affirmatively to an “Are You OK?” pop-up window. Once Man Down begins alerting, you can 

cancel it by selecting the Cancel 911 menu or selecting Off in the Man Down menu. The 

following settings are configurable through this menu: 

Active fence 

Symbol turns 
green when the 
device is inside 
an active fence 
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Figure 23: Man Down Options 

Time Down Duration — the amount of time the device must remain motionless before the “Are 

You OK?” menu displays. Whether the SHOUT ts is “Motionless” depends on a set of motion 

parameters configured using the SatTerm software. 

Count Down Duration — the amount of time for you to respond to the “Are You OK?” pop-up 

menu. If the countdown expires or you select No, the selected Man Down Alerts will trigger. 

Alerts — any combination of the following three alerts can be selected. 

Locator Alert Configurable audio alert that sounds until the Man Down Alert is 

disabled. You can set the alert type from the Audio menu. 

Start Emergency Starts emergency mode as if the red Emergency 911 button were 

pressed. 

Send Message Sends a text message with a Man Down short code and GPS location 

information. 

6.9 CALL OUT 

The Call Out option allows the SHOUT 3G to send a scheduled daily tracking report at a 

defined Greenwich Mean Time (GMT) time using a specific link. Scheduled times are 

entered via SatTerm software, and are listed under the Call Out menu. When a Call Out time is 

selected, the  symbol lights up from dimmed gray to bright white on top of the screen. 

Symbol is shown 
when Man Down is 
enabled 



  SHOUT 3G User Guide Version B 

Document Number: 451-93218-002B 48 of 69 

The Call Out option is useful when you need the device to transmit at a specific time and/or 

want to generate a daily heart beat message for each link. Refer to the “SatTerm for SHOUT 3G” 

manual [2]. 

6.10 Q RPT 

The SHOUT 3G’s default setting is to discard all tracking reports that failed to transmit 

because of poor signal quality. Use Queue Report [Q Rpt] to force failed tracking reports 

to stay in the Outbox and wait to be resent at a later time. Refer to the Outbox section on 

description of when failed tracking reports get resent. 

6.11 BLK RPT 

The SHOUT 3G’s default setting is to send all tracking reports, even those with an invalid 

GPS position. Use Block Report [Blk Rpt] to configure the SHOUT 3G to send only tracking 

reports with a valid GPS position. 

6.12 DATA LOG 

The SHOUT 3G’s default setting is to log and save all position reports in its circular 

memory. You can turn off this feature with the Data Log menu. When the 3G’s memory 

is full, the oldest reports are overwritten. You can use SatTerm to retrieve all position reports 

saved on the 3G. 

6.13 STATS 

The Stats menu has a countdown timer to the next report at the top of the screen and is 

replaced with Off when tracking is disabled. The bottom half of the screen displays the 

last successful report sent by tracking or emergency notification. Check-In, Waypoint, free-text, 

and canned messages are not considered as “reports,” and therefore are not displayed even if a 

message was sent successfully. 

6.14 CANCEL 911 

After pressing the red Emergency 911 button  on the back of the 3G or activating the 

Man Down, you can deactivate the emergency alert by selecting the Cancel 911 option. 

The cancellation message is then queued in the Outbox to be transmitted. The emergency 
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mode ends immediately. The emergency LED  is turned off and the top bar turns from red 

back to black. 

Turning the 3G off does not cancel the emergency mode. You MUST select the Cancel 911. 

option to cancel the emergency. 
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7 UTILITIES MENU 
The Utilities menu provides six options used mainly to check for proper hardware 

operation and network setup. 

 

Figure 24: Utilities Menu 

7.1 CHK GPS 

The Check GPS [Chk GPS] option forces the SHOUT 3G to turn on its GPS receiver and to 

continuously update and display GPS data in real-time. The GPS receiver remains on until 

you leave this screen by pressing the back button. Use the Reset Ephemeris key (shown in 

Figure 25) to force the 3G to erase saved ephemeris in its memory and download a new set of 

ephemeris data from the satellites. Be careful not to deplete the battery power by staying on 

this option for too long. 



  SHOUT 3G User Guide Version B 

Document Number: 451-93218-002B 51 of 69 

 

 

Figure 25: Reset Ephemeris Key 

Monitor the accuracy of the position by observing the Horizontal Accuracy (HACC). HACC is 

measured in meters. HACC is defined as the radius of a circle centered on the true value that 

contains the GPS measurement. Thus, a position fix with ten meters’ HACC accuracy indicates 

that it is within ten meters of the true position—the higher the HACC value, the less accurate 

the GPS measurement. 

The Chk GPS option is a good indicator of whether or not the GPS receiver has sufficient signal 

to initiate a Waypoint or a Test Report when located in a challenging environment, e.g., in 

dense foliage or around urban settings with tall buildings. You can monitor HACC in real-time to 

ensure it converges to a small and stable value (usually less than 30 meters). At which point, it 

is certain that a 3D fix can be obtained with the most current ephemeris data being updated 

and saved. You can then go back to the Utilities menu to send a test report. When the GPS 

receiver cannot acquire a fix, HACC gradually increases and at some point stops at a value of 

4294967.500. It is an indication that the surrounding obstructions prevent the GPS receiver 

from obtaining a fix and you should move on to a different location. 
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7.2 CHK IRIDIUM 

The Check Iridium [Chk Iridium] option forces the SHOUT 3G to turn on its Iridium 

transceiver and continuously update and display signal strength in real-time. The Iridium 

transceiver remains on until you leave this screen by pressing the back button. Be careful not to 

deplete the battery power by staying on this option for too long. 

7.3 CHK GSM 

The Check GSM [Chk GSM] option forces the SHOUT 3G to turn on its cellular transceiver 

and continuously update and display signal strength in real-time; ensure the device has 

an active cellular SIM card. The cellular transceiver remains on until you leave this screen by 

pressing the back button. Be careful not to deplete the battery power by staying on this option 

for too long. 

7.4 TEST RPT 

When you select the Test Report [Test Rpt] option is selected, the SHOUT 3G 

immediately turns the GPS receiver on to update its location data. The location 

information is continuously updated and displayed in real-time whether there is a valid fix or 

not. Similar to the Chk GPS option, you can monitor HACC to determine if a valid fix is possible. 

Once a valid fix is obtained, the GPS receiver is turned off and the most recent 3D fix 

information is displayed on the screen. This information (called test report) can be forced to 

send to a NOC server by pressing Send. A test report has the same format as a regular position 

report and is treated as such by a NOC. Sending a test report will not disrupt or change the 

tracking reporting rate. 

The Test Rpt option is a good diagnostic tool used to ensure proper operation of the GPS 

receiver, the Iridium transceiver, and the cellular transceiver. It can also be used to manage 

battery life by turning off tracking mode and strategically sending on-demand location reports. 

It can be considered as “manual tracking mode.” 
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7.5 CHK-IN 

Use the Check-In [Chk-In] option to send a quick message with a single, easily accessed 

button. You can add the Chk-In icon to the home screen favorites bar for quicker access. 

When you press the Chk-In button, a second screen appears requesting confirmation. Once 

confirmed, the SHOUT 3G sends out a reserved canned message code representing a Chk-In 

message. If the Texting/Inc GPS option is enabled, GPS location is attached to the Chk-In 

message. Chk-In messages with GPS location take longer to complete because the 3G has to 

acquire a GPS fix first. 

7.6 WAYPTS 

Use the Waypoints [Waypts] option to acquire, view, save, delete, or send a waypoint to 

a NOC. The 3G can save up to 1,000 waypoints in its circular memory. SatTerm can be 

used to retrieve waypoints saved on the 3G. 

A waypoint is a GPS location that you want to identify and mark with a specific name tag for 

future reference.  

1. Select New. The SHOUT 3G immediately turns the GPS receiver on to acquire a fix.  

2. Select one of the following options:  

a. Go back without further action. 

b. Reacquire a new GPS fix. 

c. Label the point. 

i. Select the Label option to open a full keyboard to enter the waypoint label. 

d. Save the waypoint.  

i. Select Add to save the waypoint into the 3G’s nonvolatile memory for later 

retrieval.  

ii. After saving a waypoint, you can also send it to a NOC server. The server 

differentiates waypoint reports from normal tracking reports by their short 

codes. 
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8 SETTINGS MENU 
Use the Settings menu to view and configure the SHOUT 3G hardware settings. 

 

Figure 26: Settings Menu 

8.1 AUDIO 

Use the Audio option to change the frequency, tone, and mute setting of a variety of 

audio alerts including incoming messages, general error, geofences, and man down 

locator alert. In addition to the individual settings, all audio settings can be muted through a 

single setting (except the locator alert). The  icon appears at the top of the screen if Mute All 

is on. Use Preview to test the audio volume and sound before selecting. 

8.2 BACKLIGHT 

Use the Backlight option to set the period of inactivity, after which the SHOUT 3G turns 

the Liquid-crystal display (LCD) backlight off. Set the backlight to Always On for nighttime 

use, but note that it will increase power consumption and reduce battery life. 

8.3 CALIBRATE 

A resistive touchscreen drifts slowly over time and needs to be recalibrated periodically. 

The Calibrate option allows you to either reset the calibration back to factory settings, or 

to recalibrate specifically to the current condition of the touchscreen. If the 3G is accidently 

recalibrated with erroneous settings and you are unable to use the touchscreen to recalibrate 
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or reset to factory settings, with the 3G powered off, hold the Power/Back button for ~7 

seconds or until the reset calibration screen opens. DO NOT connect the 3G’s USB port to any 

device. 

8.4 CONTRAST 

Use the Contrast option to change the LCD brightness. Slide the contrast bar to the 

desired setting and press back to accept. 

8.5 FAVORITES 

Use the Favorites option to select any icon to appear at the bottom of the home screen. 

This allows quick and easy access to the most frequently used options. A maximum of 

four active favorite icons is allowed. The icons appear left to right in the order selected. 

8.6 GPS 

The GPS menu provides access to the Position Format and Position Model options.  

Use Position Format to select one of four different GPS position formats to be displayed 

on the LCD screen. Do not confuse this option with the Format option under Tracking, which 

defines the format of position report to be transmitted to a NOC. 

Use Position Model to formulate the static and dynamic characteristics of the GPS receiver. By 

default, the portable model is used as it is suitable for most applications. However, for those 

requiring functionality at high altitudes, speeds, or accelerations, select an alternate model. 

 Portable (default setting): Suitable for most situations; for applications with low 

accelerations; maximum altitude of 12 km; maximum velocity of 310 m/sec (1,116 

km/h); maximum vertical velocity of 50 m/sec; sanity check type: altitude and velocity; 

maximum position deviation: medium. 

 Stationary: Used in timing applications (antenna must be stationary) or other 

stationary applications; velocity is constrained to 0 m/s; zero dynamics assumed; 

maximum altitude of 9 km; maximum velocity of 10 m/sec; maximum vertical velocity 

of 6 m/sec; sanity check type: altitude and velocity; maximum position deviation: small. 
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 Pedestrian: Applications with low acceleration and low speed, as a pedestrian would 

move; assuming low accelerations; maximum altitude of 9 km; maximum velocity of 30 

m/sec; maximum vertical velocity of 20 m/sec; sanity check type: altitude and velocity; 

and maximum position deviation: small. 

 Automotive: Used for applications that can be compared with the dynamics of a 

passenger car; assuming low vertical acceleration; maximum altitude of 6 km; 

maximum velocity of 84 m/sec (303 km/h); maximum vertical velocity of 15 m/sec; 

sanity check type: altitude and velocity; and maximum position deviation: medium. 

 Sea: Recommended for applications at sea; assuming zero vertical velocity; maximum 

altitude of 500 m; maximum velocity of 25 m/sec; maximum vertical velocity of 5 

m/sec; sanity check type: altitude and velocity; and maximum position deviation: 

medium. 

 Airborne < 1g: Used for applications that have to handle a higher dynamic range than a 

car and higher vertical accelerations; no 2D position fixes supported; maximum altitude 

of 50 km; maximum velocity of 100 m/sec (360 km/h); maximum vertical velocity of 

100 m/sec; sanity check type: altitude; and maximum position deviation: large. 

 Airborne < 2g: Recommended for typical airborne environment; no 2D position fixes 

supported; maximum altitude of 50 km; maximum velocity of 250 m/sec (900 km/h); 

maximum vertical velocity of 100 m/sec; sanity check type: altitude; and maximum 

position deviation: large. 

 Airborne < 4g: Only recommended for an extreme dynamic environment; no 2D 

position fixes supported; maximum altitude of 50 km; maximum velocity of 500 m/sec 

(1,800 km/h); maximum vertical velocity 100 m/sec; sanity check type: altitude; and 

maximum position deviation: large. 

8.7 LANGUAGE 

Only English is available for this firmware version. 
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8.8 LED 

The SHOUT 3G has a status LED  at the bottom-left corner to indicate whether the 

device is in emergency mode, tracking mode, geofence tracking, mailbox check, or call out. 

Except for the emergency mode, the LED flashes once every five seconds when other modes are 

enabled and the device sleeps. The LED turns solid green when the emergency mode is 

enabled. You can turn off the LED for either of these two cases to save battery power using the 

LED option. 

8.9 RESET 

The Reset option restores all setup parameters back to the manufacturer’s settings. 

When Reset is selected, a screen appears with the current settings and a confirmation 

message asks whether or not to reset these current settings back to the manufacturer’s default 

settings. 

8.10 SEARCH 

Use the Search option to set the search parameters for canned messages, contact list, 

and mailboxes. 

8.11 SECURITY 

Use the Security option to enable or disable the power-up PIN code and Access Control 

List PIN code and to set up the Access Control List. The PIN code can be up to a four-digit 

number. 

Use the Access Control List (ACL) to set which menu icons are visible. If a menu option is 

disabled in the ACL, it is also removed from the favorites. 

8.12 TIME/DATE 

Use the Time/Date option to select UTC time and date formats to be displayed on the 

LCD screen for all menus. The local time zone can also be set. 
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8.13 UNIT INFO 

The Unit Info option displays the model number, Iridium module’s International Mobile 

Equipment Identification (IMEI) number, Iridium FCC ID, Iridium IC ID, GSM FCC ID, GSM 

IC ID, 3G’s firmware version, and 3G’s bootloader version. 

8.14 USER INFO 

The User Info option displays the user information entered using SatTerm software. 
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9 ADDITIONAL FEATURES 

9.1 EMERGENCY (911) BUTTON 

The Emergency 911 button  is located underneath a red, rotating guard at the back of the 

SHOUT 3G. Use it at any time regardless of the tracking status (enabled or disabled) or power 

status (on or off). When pressed, the emergency LED  immediately turns solid green to 

indicate that the device is in emergency mode. The device then attempts to quickly send three 

consecutive reports. Because these reports are sent quickly, a GPS fix may not be immediately 

available; however, the emergency indication flag will be set. After sending the first three 

emergency reports, the 3G reverts back to the default emergency Time-Between-Reports (TBR) 

of two minutes. The LED can be deactivated to extend the battery life by using the Settings > 

LED menu. If the LCD screen is on during emergency activation, the black bar across the top of 

the screen turns red. During emergency a NOC can send an acknowledgement back to the 3G. 

 

Figure 27: Emergency Mode Display 

The status LED turns 
solid green under 
Emergency mode. 

This bar turns from 
black to red under 
emergency mode. It 
turns back to black 
when the device is 
taken out of 
emergency mode. 
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9.2 STATUS LED 

There is one status LED at the bottom-left of the SHOUT 3G. The LED turns solid green when the 

3G is in emergency mode, which can be turned off to save power using the Settings > LED 

menu, as shown in section 8.8. During normal tracking, it flashes once every five seconds when 

the 3G sleeps. It can be turned off to save power using the Settings > LED menu. 

9.3 POWERING 

Turn off the SHOUT 3G by holding the Power/Back  button for approximately two seconds. 

A power-down screen appears with a message indicating tracking and messaging will be 

completely turned off. The screen stays on for approximately ten seconds before turning off. 

Press Turn Off to turn off the 3G immediately, press Lock to go back to the power-up screen, or 

press Cancel to return to the previous screen. 



  SHOUT 3G User Guide Version B 

Document Number: 451-93218-002B 61 of 69 

APPENDIX A: PMS FEATURES 

A.1 TRACKING 

The SHOUT 3G is capable of sending position reports in PECOS Message Structure (PMS). 

PMS complies with the Blue Force Tracking Data Format Specification as defined in the 

document PECOS 200907-001 Version 1.7 [1]. The 3G is shipped without PMS features activated 

and can only be enabled by NAL Research at the request of an authorized user. When PMS is 

enabled, the Format menu has an additional option called PECOS, as shown in Figure 28 below. 

 

Figure 28: PECOS Option in Format Menu 

A.2 BREVITY 

With PMS enabled, you have the option to select any one of sixteen brevity codes (0000 

through 1111) to be included in the PMS tracking reports. These codes are represented 

by A(z), B, C(z), and D, and can be selected via the touchscreen. Each code lights up as a green 

dot inside the Brevity icon when selected. 

A.3 COMPOSE 

With PMS enabled, the Compose menu (refer to section 5.5) does not allow you to enter 

an email address from the keyboard. The address must be chosen from the contact list. 
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A.4 CONTACTS 

With PMS enabled, use the Contacts menu (refer to section 5.6) to enter and save a 

contact(s) via the keyboard. The contact(s) can only have two fields—Name and IMEI 

number. 
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APPENDIX B: UPGRADING THE FIRMWARE 
The SHOUT 3G firmware can be upgraded using a PC connected to the USB port of the device. 

The device drivers support Windows XP, Windows 7, and Windows 10. 

To upgrade the firmware: 

1. Run the NAL USB Firmware Loader program provided as part of the firmware download 

from the NAL Research website 

(https://www.nalresearch.com/support/documentation-downloads/). 

 

Figure 29: NAL USB Firmware Loader Program 

2. With a USB cable attached to a computer and the device, press Start Flash Mode. 

3. Wait until it activates and then press Browse. 

4. Browse and select a valid NAL device BIN file.  

Note: NAL Research makes the BIN file available upon request. 

5. Once the BIN file is loaded, press Program. 

Wait for the programming to complete. A message box pops up, indicating the loading 

is complete. The new firmware is now loaded on the device. It may take a few 

moments for the memory to initialize after the upgrade. 

https://www.nalresearch.com/support/documentation-downloads/
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APPENDIX C: POWER CONSUMPTION 
The SHOUT 3G has an internal 2.15 Ah Li-ion rechargeable battery. When both the 

Iridium/cellular and GPS antennas have an unobstructed view of the sky and the battery is fully 

charged, the 3G is capable of sending more than 1,600 tracking reports with the following 

settings: (1) report rate of less than two hours, and (2) mailbox check rate and the report rate 

are the same. If the Iridium antenna is blocked or an overhead Iridium satellite is not available 

(or cellular antenna is blocked by metallic structures), the Iridium/cellular transceiver can 

potentially stay on for a significant amount of time (depending on the Time-To-Keep-Trying 

(TTKT) setting) attempting to send a report. This can greatly reduce the expected number of 

reports transmitted on a single battery charge. In a poor signal environment there is a tradeoff 

between battery life and the chance that a report will be transmitted for a given report cycle; 

you may want to do some testing to determine the best TTKT for your application and 

conditions. 

The 3G saves valid ephemeris data after each 3D fix. The data is used to reduce acquisition time 

in the next reporting cycle from cold-start to hot-start. If the ephemeris data is older than about 

two hours (that is, time between reports is set for more than two hours), the GPS receiver goes 

through cold-start each time it wakes up to send a report adding approximately 30 more 

seconds of non-sleep time to each report cycle. As a result, the 3G configured for report rate of 

more than approximately two hours can be expected to transmit only approximately 800 

tracking reports. 

Important: Data presented here are only estimates and are highly dependent on the operating 

environment and Iridium antenna installed. Data are based on multiple measurements made 

with SHOUT 3G devices configured with the supplied Iridium antenna, placed on the roof of 

NAL Research’s facility with little to no blockage/shading. 
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APPENDIX D: DESIGN SPECIFICATIONS 

D.1 MECHANICAL SPECIFICATIONS 

Dimensions:  ...............................................................4.97” x 2.51” x 0.88” (126 mm x 64 mm x 22 

mm) (not including antenna) 

Weight:  ......................................................................~8.6 oz (244 g) 

Enclosure: ...................................................................Hard anodized aluminum housing/EMI 

shielding, ABS plastic radome 

Connectors:  ...............................................................USB Micro-B, Micro SIM reader  

Antennas: ...................................................................Iridium, GPS, and Cellular 

Buttons: ......................................................................One Power/Back button 

Emergency: ................................................................Guarded button 

LED: ............................................................................One status LED 

Screen: .......................................................................3.0” TFT 400 x 240 pixels 

D.2 ELECTRICAL SPECIFICATIONS 

USB Input Voltage: .....................................................5.0 VDC nominal, 4.4 V to 6.6 VDC 

Max USB Current sink: ...............................................1.5 A @ 5.0 VDC 

Battery Type: ..............................................................Lithium-ion 

Battery Capacity: ........................................................2.15 Ah 

Recharge Cycles: ........................................................500 cycles 

Power Consumption: .................................................See Appendix C: Power Consumption 

D.3 IRIDIUM TRANSCEIVER 

Operating Frequency: ................................................1616.0 to 1626.5 MHz 

Duplexing Method: ....................................................TDD 

Multiplexing Method: ................................................TDMA/FDMA 

Link Margin Downlink: ...............................................13 dB average (free space) 

Link Margin Uplink: ....................................................7 dB average (free space) 
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D.4 CELLULAR TRANSCEIVER 

Receiver Type: ............................................................u-blox LISA-U230, 3.75G 

RF Impedance: ...........................................................50 

Supported Bands: .......................................................UMTS/HSPA: I, II, IV, V, VI, VIII (2100, 1900, 

1700, 850, 800, 900 MHz) 

GSM/GPRS/EDGE: quad band 

(850/900/1800/1900 MHz) 

GSM/GPRS power Class: ............................................Class 4 (33 dBm) for GSM/EGSM (850/900 

MHz) 

Class 1 (30 dBm) for DCS/PCS (1800/1900 

MHz) 

GPRS data rate: ..........................................................up to 85.6 kbps down/up (multi-slot class 

12) 

EDGE power class: ......................................................E2 (27 dBm) for 850/900 MHz bands 

E2 (26 dBm) for 1800/1900 MHz bands 

EDGE data rate: ..........................................................up to 236.8 kbps down/up (multi-slot class 

12) 

WCDMA/HSPA power class: ......................................Class 3 (24 dBm) 

HSUPA cat 6 data rate: ...............................................up to 5.76 Mbps up 

HSDPA cat 14 data rate: .............................................up to 21.1 Mbps down 

WCDMA PS data rate: ................................................up to 384 kbps down/up 

D.5 GPS RECEIVER 

GPS Receiver: .............................................................MAX-6Q 

Receiver Type: ............................................................L1, C/A, 50-channel 

Update Rate: ..............................................................5 Hz 

Accuracy: ....................................................................2.5 m CEP (position) 

2.0 m CEP (SBAS) 

Acquisition: ................................................................26 seconds cold-start 

<1 second hot-start 
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Sensitivity: ..................................................................–161 dBm (tracking) 

–160 dBm (hot-starts) 

–148 dBm (cold-starts) 

D.6 ENVIRONMENTAL SPECIFICATIONS 

Operating Temperature: ............................................–4°F to +140°F (–20°C to +60°C) 

Charge Temperature: .................................................32°F to +113°F (0°C to +45°C) 

Operating Humidity: ..................................................≤ 75% RH 

Storage Temperature: ................................................–4°F to +140°F (–20°C to +60°C)  

Storage Humidity: ......................................................≤ 93% RH 
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APPENDIX E: STANDARDS COMPLIANCE 
The SHOUT 3G has an internal Iridium 9603 transceiver and u-blox LISA-U230 module. The 9603 

is tested to the regulatory and technical certifications shown below. It is assigned to the FCC 

Identifier Q639603. The LISA-U230 is assigned to the FCC Identifier XPYLISAU230. 

Table 2: Standard Compliance 

Regulatory 
Approvals 

Radio Tests EMC Tests Mechanical/ 
Electrical Tests 

CE 
ETSI EN 301 441 V1.1.1 
(2000-05) 

ETSI EN 301 489-20 
V1.2.1(2002-11) 

ETSI EN 301 489-1 
V1.8.1(2008-04) 

EN61000-4-2: 1995/A2: 
2001 Part 4.2 

EN61000-4-3: 2002 Part 
4.3 

EN61000-4-4: 2004 

EN61000-4-6: 1996/A1: 
2001 Part 4.6 

EN55022:2006 

EN60950-1:2006 
Part 1 

FCC 
FCC CFR47 Parts 2, 15, 
and 25 

  

IC 
Industry Canada (IC) 
RSS170 Issue 2, March, 
2011 
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APPENDIX F: EXPORT COMPLIANCE 
The SHOUT 3G is controlled by the export laws and regulations of the United States of America 

(USA). It is the policy of NAL Research to fully comply with all U.S. export and economic sanction 

laws and regulations. The export of NAL Research products, services, hardware, software, and 

technology must be made only in accordance with the laws, regulations, and licensing 

requirements of the U.S. Government. NAL Research customers must also comply with these 

laws and regulations. Failure to comply can result in the imposition of fines and penalties, the 

loss of export privileges, and termination of your contractual agreements with NAL Research. 

The export and re-export of NAL Research products and services are subject to regulation by the 

Export Administration Regulations (15 CFR 730-744), as administered by the U.S. Department of 

Commerce, Bureau of Industry and Security (“BIS”).  

See: https://www.bis.doc.gov/index.php/regulations/export-administration-regulations-ear for 

further information on BIS and the Export Administration Regulations (EAR). Additional export 

restrictions are administered by the U.S. Department of the Treasury’s Office of Foreign Asset 

Controls (“OFAC”). See: http://www.ustreas.gov/ofac for further information on OFAC and its 

requirements. 

https://www.bis.doc.gov/index.php/regulations/export-administration-regulations-ear
http://www.ustreas.gov/ofac

